
OsoSoft's Prompter 2.1
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Unregistered Shareware Version

INTRODUCTION 

Public speaking is a tough job at best, but at one time or another, we all have to prepare 
and give a speech, short talk, or presentation. Aside from the nervousness we all feel 
about this unfamiliar activity, it's just not something most of us enjoy. But there are ways 
to make this unpleasant task as easy as possible. Prompter  is one of those ways.

Using Prompter to prepare, rehearse, and print out your speech is part of the answer. The 
program includes all the tools you need to write a speech and print out hard copies of 
your talk, for use at the lectern or as handouts. But there's more than that to Prompter.
Prompter offers automatic scrolling of your speech, with adjustable font sizes and 
scrolling rates. You can use this to rehearse your talk as often as you like. There's even a 
built-in timer which tells you exactly how long your speech will last.

Finally, with any Windows-capable notebook computer, you can display your speech as 
you give it. It works just like the expensive prompters used by professional public 
speakers. While giving the speech, using Prompter on the dais, you can instantly pause 
the scrolling, alter the speed with the touch of a key, and move freely around in your text.
Prompter also includes automatic mirror image screen display for users who have 
professional prompting mirrors.

If you give more than a couple of talks, speeches, or presentations a year, you can't do 
without Prompter. It will help make you a more effective speaker and dramatically cut 
down on pre-speech jitters and stage fright.

PROMPTER'S FEATURES

Built-In Speech Editor
Uses a Very Readable San Serif Font
Includes a Mirror-image Font for Professional and Studio Prompting
Pronunciation Character Inserter
Adjustable Font Size
Adjustable Scroll Rate
Elapsed Time Counter
Maximum Delivery Time for a Single File is One Hour
Delivery Time Display during Editing
Instant Keyboard Control during Prompting.
Fully Paginated Printouts of your Speech



Prints Speeches in Any Font Size
Imports ASCII Files from Other Programs
Easy to Use
Low Cost

LICENSE INFORMATION

This is the unregistered version of Prompter 2.1. Prompter is a shareware program. You 
may try this copy of the program for a period not to exceed 30 days to determine whether 
or not it is suitable for your needs. After that time, if you continue to use the program, 
you must register your copy with the author. To register, use the OsoSoft Program Info 
command in the Help Menu to fill out print the registration form. The Registration fee for
this program is $25.

You can also register with a Visa or MasterCard by calling OsoSoft at (805) 528-1759 
during normal West Coast business hours. OsoSoft programs may also be registered on 
CompuServe in the SWREG forum. Registrations will be charged to your CompuServe 
account.

Registered users receive the very latest version of the program, a printed manual, 
automatic notification of major upgrades, and support. In addition, when you register, 
you'll always be entitled to upgrade to new registered versions at no charge on the 
OsoSoft BBS at (805) 528-3753. Registered users are entitled to unlimited free support 
by telephone, fax, on the OsoSoft BBS, and on Compuserve.

Unregistered users receive only a minimum of support, limited to some installation help, 
if necessary, and are not entitled to telephone support. If you call the OsoSoft voice 
number for support as an unregistered user, you will be asked to register at that time by 
credit card.

Please help keep the Shareware concept alive: Register ALL Shareware 
programs you use!

Users of this program, along with traditional shareware distributors may distribute copies 
of  the shareware versions of this program, but only under the terms described in the 
VENDOR.DOC file included with this copy of the program. All commercial distributors 
MUST read that file and abide by the distribution rules contained in that file. Violations 
of the distribution license in VENDOR.DOC may result in prosecution under appropriate 
copyright laws of the United States and other countries.

Prompter and all related files, including this documentation are Copyright 1994 by 
OsoSoft. All rights are reserved.

OsoSoft is a member of the Association of Shareware Professionals and the Software 
Publishers' Association.



OsoSoft
1472 Sixth Street
Los Osos, CA  93402
OsoSoft BBS: (805) 528-3753
Voice Order Line: (805) 528-1759
CompuServe ID: 71571,222

OsoSoft's CompuServe Support Forum

OsoSoft maintains a support forum on CompuServe for the convenience of its customers. 
To reach this forum on CompuServe, use the GO word OsoSoft. Current versions of all 
OsoSoft programs, along with other files and a message area are always available.

HOURS

OsoSoft office hours are 7 AM to 4 PM, Pacific Time, on weekdays. Calls outside those 
hours are not appreciated.

ASP OMBUDSMAN NOTICE

This program is produced by a member of the Association of Shareware Professionals 
(ASP). ASP wants to make sure that the shareware principle works for you. If you are 
unable to resolve a shareware-related problem with an ASP member by contacting that 
member directly, ASP may be able to help. The ASP Ombudsman can help you resolve a 
dispute or problem with an ASP member, but does not provide technical support for 
members' products. Please write to the ASP Ombudsman at 545 Grover Road, Muskegon,
MI 49422-9427 USA FAX 619-788-2765 or send a CompuServe message via 
CompuServe mail to ASP Ombudsman 70007,3536.

INSTALLATION

The Shareware version of Prompter use a manual installation technique. The Registered 
Version includes an automated installation program. To install this program, take the 
following steps. If you need help with any of the file and directory procedures, consult 
your Windows or DOS Manual.

1. Copy all files from the distribution diskette or the ZIP file containing the program into 
a directory on your hard disk. OsoSoft recommends that you create a directory called 
PROMPTER for the files.

VBRUN300.DLL REQUIRED

The shareware and online update versions also require VBRUN300.DLL, which must be 
installed in the WINDOWS\SYSTEM directory. If you do not have a copy of that file, 



you may download it as VBRUN300.ZIP from the OsoSoft BBS at (805) 528- 3753, or 
obtain it from the source where you got your copy of the shareware version. You may 
also obtain a copy of this file as VBRUN3.ZIP in OsoSoft's CompuServe Support section.

2. If Windows is not running, start it. Then, from the Program Manager, click once inside 
the program group where you want the Prompter icon. Then, select the New command 
from the Program Manager's File menu. Make certain the Program Item option is 
selected, then click OK or press <Enter>.

3. In the Description field of the resulting dialog box, type Prompter, then press <Tab>.

4. In the Command Line field, type C:\PROMPTER\PROMPTER.EXE, substituting 
other drive and directory information, if necessary. Press <Tab>.

5. In the Working Directory field, type C:\PROMPTER, or substitute other drive and path
information, if necessary.

6. Press <Enter> or click OK to complete the installation. The Prompter icon will appear 
in the program group you selected earlier.

Prompter's Font Files

Prompter uses its own TrueType fonts for all display purposes and for printing. These 
fonts, PRNormal and PRMirror should be installed with the program and are included 
with the program. The files, PRSANSN.TTF and PRSANSR.TTF must be located in the 
same directory as PROMPTER.EXE. If these files cannot be found, Prompter will revert 
to the Arial font, and will be unable to use mirrored text or pronunciation characters.

SYSTEM REQUIREMENTS 

Prompter requires a 386SX or better PC, Windows 3.1 operating in Enhanced Mode, and 
a minimum of 2 MB of memory. You'll also need 1 MB of disk space for installation, plus
a mouse and a valid video display with 640 X 480 resolution minimum.

STARTING PROMPTER 

To start Prompter, double-click its icon in the Program Manager. Once Prompter starts, 
you'll see its main window. The editing and display window for your speech takes up 
most of the screen. Here is where you'll both create, edit, and display your speech.

TUTORIAL

Configuring Prompter

Before creating your first Prompter speech, you need to set the program up to match your



own personal delivery style. Rates of speech and other elements vary widely from 
speaker to speaker. To help you with this, Prompter includes the text of three speeches, 
stored in .LEC files in your Prompter directory. The first is Lincoln's Gettysburg 
Address, possibly the most famous speech of all time. There are also two professionally-
written radio addresses by President Bill Clinton, which you can also use to help set up 
Prompter's default settings. 

Select File-Open from the Prompter menu, then choose CLINTON1.LEC or one of the 
other LEC files in the file list, then click [OK] in the dialog box. Prompter will load the 
speech into the display window. Prompter starts with default scroll rates and font sizes, 
typical of good speech practices.

Set the font size on the screen with the scroll bar to a size you'll be able to read under 
normal speechmaking. Next, click the [Prompt] button at the upper left of the Prompter 
window. Immediately, you'll see the cursor begin to travel down the screen at the preset 
pace. Wait for the cursor to move down a few lines, then speak the text aloud. If you find 
yourself falling behind the scroll rate or if the screen scrolls too slowly, change the rate 
by pressing the Plus (+) key on your keypad to speed it up or the Minus (-) key to slow 
the rate down. You'll see the change reflected in the Lines per Minute (lpm) number at the
top of the window. Experiment with speeds until you find a rate which suits you best. 

REMEMBER: Public addresses are normally given at a slower rate than normal 
conversation. You may feel that you're speaking too slowly, but your rate of delivery 
should be somewhat slower than normal speech.

At any time during this process, you can pause the scrolling by pressing any 
alphanumeric key on your keyboard, including the space bar. Scrolling will stop instantly.
To resume scrolling, press any key again. While scrolling is paused, you can use any 
directional key on your keyboard to move the cursor to a new location. While scrolling is 
on, you can use the same keys to jump in the text. This takes a bit of practice, so 
experiment with the keys while scrolling.

HINT: <Ctrl>-<Home> and <Ctrl>-<End> move to the top and bottom of the text. 
To stop scrolling altogether, click the [Edit] button. Scrolling will stop and the font size 
of the editing menu will decrease to allow for easy text editing. At the same time, 
disabled menu items will become available again. You can only use Prompter's menus 
during editing, not during scrolling.

Once you've established a scroll rate which seems comfortable, select Options-Save 
Settings as Defaults. This will make the settings you've found that work for you the 
normal settings whenever you start Prompter. Speed and font size settings are also stored 
in the program's LEC files, created whenever you save a speech file, so each speech can 
have its own settings. You can change these settings and save new defaults at any time.

Creating a New Speech



If Prompter is already running, select the File-New to clear your screen. Otherwise, just 
start the program to begin writing your speech. In either case, click the [Edit] button to 
enable the program's menus and set the screen's font size to 12 points for editing. While 
in Edit mode, the screen's font size is normally 12 points. If you prefer to edit in the 
actual size your speech will use during prompting, select the Options menu and click the 
Edit with Prompting Font Size command. This will instantly switch the display to the 
new font size. To return to normal, 12 point type, repeat this command. Shortcut: Press 
<Ctrl>-S to toggle font sizes.

Prompter's editing area works much like any Windows word processor. You just type as 
you would normally, pressing <Enter> only when you reach the end of a paragraph. 
Since Prompter scrolls during rehearsal or performance, it's best not to leave blank lines 
between paragraphs. Otherwise, you could find yourself on a blank line with nothing to 
say. Instead, press <Tab> at the beginning of each paragraph, unless you want blank lines
to serve as natural pauses during presentation.

Remember that you'll be speaking aloud, and allow for natural pauses in your speech. 
Also, if you'll be asking the audience for questions, add a line of text to your speech, such
as "Are there any questions?" Where you expect to make a pause, either insert a blank 
line or two, or type symbols to prompt you to press a key and pause the scrolling. Try 
#### as a pause prompt. It's easy to see, and won't be confused with something you might
say accidentally.

Continue writing and editing your speech. You can use the Copy, Cut, and Paste 
commands in the Edit menu, just as you would in your word processor. If text is selected 
or highlighted during editing new text will replace the selected text.

At any time during writing and editing, click the Estimate Duration menu command to 
see a display of the time required to give the talk at the current scroll rate and font size. 
You can alter these settings with the scroll bars.

Pronunciation of unfamiliar words can be a problem for many speakers. Prompter now 
includes a built-in pronunciation character tool. To use this, first highlight the unfamiliar 
word by double-clicking on the word. Then select Insert-Insert Pronunciation 
Characters or press <Ctrl>-P. A new window will appear, with your selected word in 
the text entry area. To insert one of the standard dictionary pronunciation characters, 
position the cursor where you want the character to go, then double-click the character in 
one of the windows below. Use the standard accent characters to indicate major and 
minor emphasis in the same way, and separate unemphasized syllables with a hyphen. 

Remember, you can type in the text editing area as well to insert normal keyboard 
characters. When you're finished, select Insert. Prompter will insert your pronunciation 
spelling following the word you previously selected, automatically enclosing it in 
parentheses. 

Prompter can edit up to 32,767 characters, which represents about an hour of speaking 



time. If your speech will extend beyond that time, create the speech in two parts, breaking
it up at the point where you plan a break. Then, when speaking, you can load the second 
part during the break.

Importing Text from Other Applications

Prompter's editor is capable of creating any speech or address. However, if you prefer, 
you can write your initial draft for your address in another program, such as a word 
processor. If you do, save the file as an ASCII or Text file in the other application, then 
load the file into Prompter. If you do this, be sure to save the imported file with a 
different file name to preserve your Prompter settings and changes. 

Saving and Printing your Speech

Once your speech is written, and as you make changes, be sure to save it. Give the File-
Save As command, then supply a file name. It's best to stick to the default LEC file 
extension, since that's the one Prompter proposes when you open existing speeches. If 
you type a filename without any extension, Prompter will add the LEC extension. As 
with all programs, be sure to save your work as you go to avoid accidentally losing your 
speech.

NOTE: Prompter saves by default in its own program directory. You can save in any 
other directory, however. When you give the Options-Save Settings as Defaults 
command, the last path selected for saving becomes the new default.

To print the currently-loaded speech, give the File-Print command. You'll be asked to 
specify a font size for the printout (the default size is 12-points). If you'll be reading the 
speech from the printout, select a larger size for easier reading. Your printout will have a 
header, showing the filename, the date, and the page number. All formatting and margins 
are set by Prompter. 

If you want a more heavily-formatted printout, you can load the ASCII LEC files saved 
in Prompter into any word processor for formatting before printing.

Rehearsing a Speech

Once your speech is written, click the [Prompt] button. The cursor will jump to the top 
of the text and begin scrolling at the rate you set previously. An elapsed time counter will 
appear at the upper left of the window. As the speech scrolls, speak in the same way you 
will during the actual presentation. As you rehearse, you can control the scrolling speed 
with the Plus (+) and Minus(-) keys on your keyboard's numeric keypad. Pause the 
scrolling at any time by pressing any normal alphanumeric key or the space bar, then 
resume scrolling by pressing any key again. If you need to edit the speech as you 
rehearse, just click the [Edit] button and make your changes. Be sure to save any changes
you've made!



NOTE: Whenever you click the [Prompt] button, Prompter begins scrolling from the top
of the file. If you've paused to do editing, press any key after pressing the [Prompt] 
button, then move to your previous location with the cursor movement keys, then press 
any key again to continue scrolling.

REHEARSAL HINTS: Be sure and rehearse several times, until you feel completely 
comfortable with your speech. Pay special attention to pauses, pacing, and the speech's 
scroll rate. Anticipate points where your audience will applaud or ask questions, marking 
these spots with a symbolic mark to remind you that you may have to press a key to 
pause when you actually perform the speech before an audience.

Also, make sure during rehearsal that you're completely comfortable with the controls in 
Prompter if you plan to use it during the actual presentation. Practice pausing and altering
scroll rates. The last thing you want is a surprise at the lectern.

Using Prompter during an Actual Speech

Have you ever noticed how smoothly professional public speakers perform? Did you ever
notice the little angled piece of glass at the lectern when professionals speak? That's a 
prompter, and the speech is being displayed on it as the speaker talks. Similarly, those 
smooth-talking news announcers are speaking that way because they're reading the text as
they speak it from a prompter.

Prompter offers you the same advantage. All you need is a notebook computer which can 
run Windows. Install Prompter on the notebook, just as you did on your desktop 
computer. You load the LEC file for your speech ahead of time, place the notebook on 
the lectern, then simply click the [Prompt] button when it's time to speak. As you saw 
during rehearsal, controlling the scroll rate or pausing and restarting the scrolling is 
simple and doesn't require much attention.

Essentially, you use the program during the speech, just as you did during rehearsal. 
You'll never lose your notes or get them out of order.

Here are some hints for using Prompter at the lectern:

1. Set up ahead of time. Make sure your notebook screen is easy to see on the lectern, and
that the angle of the screen and contrast and brightness settings are ideal.

2. When you reach the lectern, return the notebook to the same position and angle, wait 
for the applause to die down, then click the [Prompt] button or press <Alt>-P to start 
scrolling. Wait until the cursor or highlight moves down a few lines, then begin giving 
your talk. Since you've rehearsed it several times, you'll only have to refer to the screen 
occasionally.

3. If you're getting ahead of the Prompter screen, you're probably rushing your speech, a 
common problem, usually caused by nervousness. Just slow down a bit. Use the down 



arrow to catch the screen up with you, then slow your pace. Remember that you set a 
comfortable pace during rehearsal.

4. If you need to change pacing, use the + or - keys to change the scroll rate.

5. If you're interrupted with questions, just tap any alphanumeric key on the notebook's 
keyboard to pause the scrolling. When you begin speaking again, tap a key to resume.

6. If you interject an aside during your talk, again, press a key to pause scrolling, then 
press another to begin scrolling when you resume your prepared text.

NOTE:  Always have a printed copy of your speech on hand, at the lectern, just in case 
something goes wrong with your computer.

Prompting Modes

Prompter offers two prompting modes, one with highlighted text and one without. Select 
between the two in the Options menu and test to see which mode you prefer. When you 
have the program set the way you like it, select Options-Save Settings as Defaults to 
make your preferred method the default.

Working with an Assistant

Prompter can also be used with an external monitor attached to a laptop or with a 
permanent monitor setup, as in a TV studio. This works well when an assistant is 
operating Prompter as you speak. If you choose this alternative, be sure you have 
rehearsed with your assistant well in advance, that the assistant is completely familiar 
with Prompter's operation, and that you have a printed copy of the speech on hand, just in
case.

Using Mirror-Image Text

In some professional settings and in television studios, mirrors are used to reflect the 
screen display. Under these circumstances, an assistant is almost always used. Prompter 
can display its screens in a mirror-image typeface for these situations. To use this feature, 
prepare and rehearse your speech as you normally would. Make sure your font size is set 
correctly. 

Then, before beginning to prompt, select Options-Mirrored Text (<Ctrl>-M). Prompter
will scan the speech, then reverse the characters. This process may take several seconds. 
To return to normal text, for editing or other purposes, give the same command or click 
the [Edit] button.

NOTE: For mirrored text to work, Prompter's fonts must be installed in the directory 
where PROMPTER.EXE is located.



Prompter Reference

On-Screen Controls
[Edit] Button—This button returns Prompter to editing mode, with the window's font 
size set at 12 point type. The cursor will remain at the last postion it was in if you were in
Prompt mode. This button also enables menus and other controls. Keyboard Shortcut: 
<Alt>-T

[Prompt] Button—This button begins scrolling the text at the scroll rate set with the 
lefthand scroll bar. The current scroll rate is displayed in Lines Per Minute (lpm) next to 
the scroll bar. Scrolling always begins at the beginning of the file. Keyboard Shortcut: 
<Alt>-P

[Speed] Scroll Bar—This scroll bar adjusts the scrolling rate in Lines Per Minute (lpm). 
The current rate is displayed next to the bar. Click the left arrow to slow things down 
slightly or the right arrow to speed up. To slow down or speed up at larger intervals, click 
the area between the arrows on the scroll bar and the "thumb" of the scroll bar. For even 
larger changes, drag the "thumb" to a new location. Keyboard Shortcut (During 
Scrolling Only): + Increases Rate; - Decreases Rate

[Font Size] Scroll Bar—Alters Scroll Mode font size in points. The current font size is 
displayed next to the bar. Available only in Edit mode. NOTE: When you change font 
sizes, those changes won't show on the screen in Edit mode unless you've opted to edit in 
the prompting font size. To see the effect, click the [Prompt] button.

Menu Commands

File Menu

New—Clears the window in preparation for creating a new speech, with confirmation.

Open—Opens an existing LEC or other file. Displays a dialog box for selecting a file. 
By default, *.LEC is the file pattern. Type a new pattern to view files with other 
extensions. Select a file by clicking on the file name in the dialog box. Open the file by 
clicking [Open] or by double-clicking a file name. NOTE: You should save all speeches 
with the LEC extension to save time and help identify your files. You may open any 
ASCII file for viewing or editing in Prompter. NOTE: Maximum file size is 32K. Larger 
files will be truncated to that length when displayed.

Save As—Lets you save your current project as a LEC file. Save As is used in this 
program to remind you not to overwrite exisiting files, especially if they are in another 
file format. If you type just a filename, without an extension, the LEC extension will be 



added. NOTE: Once you've saved a file, the Save As command will automatically 
propose that file name for saving. To save that file or a new filename typed into the 
filename box, just click the [Save] button.

Print—After asking you for a font size, Prompter will then print your text on the current 
printer. The font used in the printout is the same one which is displayed in the text 
window. Header lines and page numbers, always in 12-point type are added 
automatically, and include the filename, date, and page number. Margins are 1", except 
for the left margin, which is 1.5" to allow easy three-hole punching. 

Exit—Exits Prompter. Be sure to save your work. If a file is loaded, Prompter will ask if 
you want to save your file before exiting.

Edit Menu

Cut, Copy, Paste—These are the normal Windows editing commands. You can use the 
menu commands or normal windows shortcut keys. <Ctrl>-X cuts, <Ctlr>-C copies, and
<Ctrl>-V pastes selected text.

Find/Find Next—Search for text. All searches are case-insensitive, which means that 
entering search text as "Bob" will find "bob," "Bob," or "BOB". Prompter remembers 
your last search text, so giving this command again will automatically insert the text for 
your last search. To search for new text, just type it in. Each time you search, you'll be 
asked if you want to begin the search from the beginning. Answer No to continue a 
search from the cursor location. Keyboard Shortcut: <F3>

Insert Menu

Insert Pronunciation Characters—Opens the pronunciation window. Before giving this
command, you should select the word for which you want to create a pronunciation. The 
selected word will appear in a text editing area. Double click on characters in the below 
to insert them at the cursor location, or type normal keyboard characters. To insert your 
pronunciation into your speech, click the Insert command. To cancel the operation, click 
Cancel. Shortcut: <Ctrl>-P

Options Menu

Use Prompt Highlight—When checked, this command adds a two line highlight during 
prompting. The highlight, after the first few lines, remains in the same place on the 
screen, with the text scrolling into it. When unchecked, there is no highlight during 
prompting. This command's status is saved when you save settings (see below). 
Shortcut: <Ctrl>-H

Edit with Prompting Font Size—Give this command to switch between editing in 12-
point type and the font size you'll use for prompting. Shortcut: <Ctrl>-S



Mirrored Text—Click this command to toggle between mirrored and normal text before 
prompting. You can also return to normal text by clicking the Edit command. Shortcut: 
<Ctrl>-M

Save Settings as Defaults—This command saves the current Font Name, Font Size, , 
Editing mode, Prompt Highlight setting, Scrolling Speed, and Path information. 
Whenever you run Prompter, it looks for this information and uses it as the default 
settings. Once you have Prompter working the way you like, use this command to save 
your settings.

Delete Default File—If you change your mind about your default settings, you can give 
this command to return to the default settings the next time you start Prompter.

Estimate Duration Menu

Click this menu command at any time while editing your speech. Prompter will display 
the time needed to give the speech or lecture at the current font size and scroll speed. Use
this command to help you edit your speech to the desired time. NOTE: This time display 
does not automatically update. You must click the command each time you want to know 
the duration. Shortcut Keystroke: <Alt>-D

Help Menu

Help with Prompter—Give this command to view a help window. To use the Help 
system, click on the topic of interest in the right-hand list. The text for that topic will 
appear at the top of the right-hand window. To return to Prompter's main screen, click 
Exit or Return to Program. Shortcut Key: <F1>

Prompter Keystrokes—For a quick reference to Prompter's keystrokes which can be 
used during scrolling, select this command. Shortcut Keystroke: <Ctrl>-K

About Prompter—This command displays a window containing program and version 
information, along with contact information for Ososoft.

OsoSoft Program Info—This command provides information on other OsoSoft products
and includes a fill-in-the blanks order form for those products. OsoSoft publishes several 
programs which may interest you. To view information on any of those products, click 
the [Info] button next to that product's name. To order, type in the quantity for each 
product, then enter your shipping information in the blanks at the bottom of the screen. 
To print an order form, click the [Print] button. To return to Prompter, click [Cancel].

Hints for Effective Public Speaking
Plan Ahead—There are a few public speakers who can ad lib a speech, but they're a rare 
breed. Unless you know that you can stand up in front of a crowd and speak effectively 
with little preparation, plan your talk thoroughly in advance. 



Write Carefully—What you say in public makes a lasting impression of you on your 
listeners. Aim for clarity, precision, and interest when writing your speech. 

Keep it Simple—There are major differences between effective written and spoken 
language. Keep sentences short and simple, and avoid obscure words and references.

Use Humor in Moderation—Humor is a good tool for keeping your audience alert and 
listening, but don't let it interfere with your message. 

Rehearse Thoroughly—Once your speech is written, practice it. 

Don't Drone—Vary your speech patterns, speaking at different volume levels and speeds
where appropriate. If you're making a point in the speech, make it emphatically.

Make Contact with Your Audience—Look at the people you're addressing. With proper 
rehearsal, you shouldn't have to read your speech. 

Anticipate Applause, Laughter, and Questions—If your speech is going well, the 
audience is going to respond with applause, laughter, and questions. That can throw you 
off your pace if you're unprepared. Watch for applause points as you write the speech.  

Keep it Brief— Even when the topic is interesting, a speech which goes on too long can 
send any audience off into dreamland. Check to see how much time is allowed for your 
talk, then use Prompter's timing tools to fit your speech into that time. 

Slow Down—It's always tempting to rush through a speech. The desire to "get it over 
with" can lead to a hurried, ineffective presentation. 

Enjoy Yourself—The enjoyment your audience feels is directly proportional to the 
enjoyment you have in speaking. If you're overly nervous, your audience will be nervous 
too. 


